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1. Understanding your CADfix purchase 
Your CADfix license will be one of the following types: 

• Evaluation 

• Single node-locked 

• Network (floating), or multiple node-locked 

Other installation configurations are available, and CADfix support can provide more advice if needed. 

 

Within this document, each of these license types are colour-coded (as above) to help with identification 

of the relevant information. 

 

 

 

Evaluation 

This installation uses a local license file that is time limited. It does not require any licensing services, 

so only CADfix needs installing. Evaluation licenses do not normally allow any type of remote access, 

but this license can be installed on multiple computers. 

 

 

Single node-locked 

A node-locked installation is locked to a specific computer which is identified by its mac address. Both 

the CADfix application and the license services are usually installed on the same computer. 

 

Where a purchase includes multiple node-locked seats, the installation can follow the ‘Network 

(floating), or multiple node-locked’ procedure.  This allows all the CADfix installations to share a single 

license server. 

 

 

Network (floating), or multiple node-locked 

A floating CADfix license will run only within a specified range of defined computers. The allowable 

range should be discussed with the CADfix sales team prior to purchase.  It will be categorised as LAN, 

WAN, RWAN, or WWAN and can be identified using the following options (or combination): 

IP address range: 126.10.10.* 
IP address list: 126.10.10.5  126.10.10.6  126.10.10.7 

MAC address list: 48ad3f56ffcb a93b2f2dd9ab  e8ff3ba826c0 
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2. Quick installation guide 
 

 

2.1. Evaluation 

Preparation 

a)  Request an ‘Evaluation’ license file. 

Usually supplied via your CADfix sales representative by email.  

or: 

Americas customers - email works_supp@iti-global.com  

Non-Americas customers - email eukeys@iti-global.com  

b)  Download CADfix 

The latest download link is supplied in the license-file email that has been sent to you - Download the 

‘Installer’ package. 

A ‘Zip file’ installation is also available for download, but this is not covered in this installation document. 

Installing CADfix and license  

c)  Install CADfix 

Run the downloaded installer program – See Installing CADfix 

d)  Copy your license file into “..\CADfix\lic” 

When received from ITI, copy the license file into the CADfix lic folder.  

e.g. “C:\Program Files (x86)\CADfix PPS4\lic\” – See Installing the license service 

e)  Run CADfix 

Double click on the desktop icon, or run the “startCADfix.bat” script in the CADfix installation folder 

(e.g.”C:\ Program Files (x86)\CADfix PPS4\ startCADfix.bat”) 
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2.2. Single node-locked 

Preparation 

a)  Request a license file. 

Usually supplied via your CADfix sales representative by email.  

or: 

Americas customers - email works_supp@iti-global.com  

Non-Americas customers - email eukeys@iti-global.com  

To create the license file, the ITI support team will need to know: 

• The CADfix workstation MAC address 

b)  Download CADfix 

The latest download link is supplied in the license-file email that has been sent to you - Download the 

‘Installer’ package. 

A ‘Zip file’ installation is also available for download, but this is not covered in this installation document. 

Installing CADfix and license server 

a)  Install CADfix 

Run the downloaded installer program – See Installing CADfix 

b)  Copy your license file into “..\CADfix\lic” 

When received from ITI, copy the license file into the CADfix lic folder.  

e.g. “C:\Program Files (x86)\CADfix PPS4\lic\” – See Installing the license service 

c) Install FlexNET services 

Detailed instructions about how to install the FlexNET services – see Configuring the license manager. 

d)  Run CADfix 

Double click on the desktop icon, or run the “startCADfix.bat” script in the CADfix installation folder 

(e.g.”C:\ Program Files (x86)\CADfix PPS4\ startCADfix.bat”) 
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2.3. Network (floating), or multiple node-locked 

Preparation 

a)  Request a license file. 

Usually supplied via your CADfix sales representative by email.  

or: 

Americas customers - email works_supp@iti-global.com  

Non-Americas customers - email eukeys@iti-global.com  

 

To create the license file, the ITI support team will need to know: 

• CADfix license server network name or IP address 

• CADfix license server MAC address 

• CADfix workstation IP address list/range, or MAC address list. 

(If multiple node-locked installation, then this must be MAC addresses list). 

b)  Download CADfix 

The latest download link is supplied in the license-file email that has been sent to you - Download the 

‘Installer’ package. 

A ‘Zip file’ installation is also available for download, but this is not covered in this installation document. 

Install CADfix license server 

a) Download and install CADfix license only on to the license server or copy a lic folder from another CADfix 

installation.  - Download the license server only from www.cadfix.eu/12LIC/  

b)  Copy your license file into “..\CADfix\lic” 

When received from ITI, copy the license file into the CADfix lic folder.  

e.g. “C:\Program Files (x86)\CADfix PPS4\lic\” – See Installing the license service 

c) Install FlexNET services  

Detailed instructions about how to install the FlexNET services – see Configuring the license manager 

Install CADfix on client workstations 

d)  Install CADfix 

Run the downloaded installer program – See Installing CADfix 

e) Link CADfix to license server – See Linking CADfix to the license 

f)  Run CADfix 

Double click on the desktop icon, or run the “startCADfix.bat” script in the CADfix installation folder 

(e.g.”C:\ Program Files (x86)\CADfix PPS4\ startCADfix.bat”) 
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3. Detailed installation procedures 

3.1. Installing CADfix 

 

1) Double-click on the downloaded installer package to start the installation process. 

e.g. CADfixPPS4.exe 

 

 

 

2) Windows may ask to allow the program to run. This will be 

signified by the highlighted shield on the taskbar .  

Select ‘Yes’ to allow the CADfix installer to run: 

 

 

 

 

3) An initial start-up screen is displayed whilst the program is loading: 

 
a) ‘Cancel’ will stop the installation process if required. 

 

 

4) The Welcome screen is then displayed: 

 
a) ‘Next’ continues with the installation process. 

b) ‘Cancel’ will stop the installation process. 
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5) The CADfix license agreement is displayed. This gives you the opportunity to review and print the 

agreement before installing CADfix. 

 
a) To continue, select ‘I accept the terms of the license agreement’, then press the ‘Next’ button. 

b) ‘Back’ will return to the Welcome screen. 

c) ‘Cancel’ will stop the installation process. 

 

 

6) The ‘Choose Destination Location’ screen 

shows the default installation location: 

(This location may vary depending on the 

version you are installing.) 

a) ‘Change…’ allows CADfix to be installed at a 

different location. 

b) ‘Back’ returns to the ‘License agreement’ 

screen. 

c) ‘Next’ continues with the installation 

process. 

d) ‘Cancel’ will stop the installation process. 

 

 

7) The ‘Ready to Install the Program’ screen allows a chance to go back to previous screens and 

make changes before writing to disk: 

 
a) ‘Back’ returns to the ‘Choose Destination Location’ screen. 

b) ‘Next’ starts installation of CADfix using these settings. 

c) ‘Cancel’ will stop the installation process. 
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8) During the installation of the files a progress bar is displayed: 

   
Pressing cancel during this stage will cancel the installation process. 

 

 

9) When the installation is complete, a message is displayed informing you of this. 

 
a) Press ‘Finish’ to close this screen 

 

 

 

 

 

 

• A ‘CADfix PPS 4’ start-up icon should now be displayed on your desktop: 

 

 

• A ‘CADfix PPS 4’ group should now be available in your Windows Start-menu: 
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3.2. Installing the license service 

CADfix utilises FlexNET license services for its license management. If it is needed, and where it is 

installed will depend on the configuration of your CADfix purchase. Please discuss this with CADfix 

support if you have any doubts or want further advice. 

 

 

 

 

 

Evaluation license 

The license server is not needed for an evaluation license.  To run an evaluation license: 

1. Ensure the supplied license file is named ‘cadfix.dat’. 

2. Copy cadfix.dat to the CADfix lic folder. 

e.g. “C:\Program Files (x86)\CADfix PPS4\lic\” 

 

 

 

 

 

 

Single node-locked 

When a license manager is required on the same computer as the CADfix application, the license 

manager can be run from within the CADfix installation. Alternatively, the license manager can be 

installed in a non-version specific location to avoid reconfiguration during subsequent upgrades (see 

‘Network (floating), or multiple node-locked’ below). 

 

 

 

 

 

 

Network (floating), or multiple node-locked 

To install the license manager software as a server there are three options available: 

• Install a full CADfix installation on the server. This will include the full FlexNET license server. 

• Download the license server installation package (www.cadfix.eu/12LIC/ ). 

The installation procedure is the same as the full CADfix installation and is therefore not 

repeated here. 

• Copy the lic folder from a CADfix installation onto the server at a static location where it can be 

run (e.g. “C:\Program Files (x86)\CADfix license\”). 

It is good to install the CADfix license in a non-version specific location to avoid reconfiguration during 

subsequent upgrades of CADfix. 
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3.3. Configuring the license manager 

This configuration process shown here uses the FlexNET graphical user interface to configure Windows 

services. The process can also be completed at the command-line and this process can be requested 

from CADfix support. 

 

1. Using the file browser, open the CADfix license server installation folder. 

This folder contains: lmtools.exe, lmutil.exe, lmgrd.exe, and itiohio.exe 

 

 

2. Place a copy of the license file (cadfix.dat) into this installation folder. 

This is a text file containing: your license information, details of the license server, and information 

about which computers can run CADfix.  This may be supplied to you with a different name and will 

therefore need renaming to ‘cadfix.dat’. 

 

 

3. Right-click on lmtools.exe and select ‘Run as 

administrator’ to start the License manager interface 

tool. 

 

 

 

 

4. If the User Account Control dialogue box appears, click ‘Yes’ 

to allow ‘LMTOOLS Utility’ to run. 

 

 

 

 

 

5. When LMTOOLS starts, open the ‘Service/License File’ tab, and select ‘Configuration using 

Services’: 
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6. Open the ‘Config Services’ tab and set the values: 

 ‘Service Name’ = “CADfix License” (Type this directly into the box) 

 ‘Path to lmgrd.exe file’ = Browse and select the lmgrd.exe file in the license installation folder. 

 ‘Path to license file’ = Browse and select the cadfix.dat file in the license installation folder.  

(You will need to change the file filter in the dialogue box from ‘*.lic’ to 

‘*.dat’ before you can see this file.) 

 ‘Path to the debug log file’ = Browse to the license installation folder and type in “cadfix.log” to create 

a new log file using this name. 

 ‘Use Services’ = ✓ 

 ‘Start Server at Power Up’ = ✓ 

 
 

7. Press ‘Save Services’ 

The Windows Services tool should now show the ‘CADfix License’ service as not started: 

 
 

8. Open the LMTOOLS ‘Start/Stop/Reread’ tab, select ‘CADfix License’, and press the ‘Start Server’ 

button. 
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• The message at the bottom of the ‘Start/Stop/Reread’ tab should now say the service has started: 

 
• The Windows Services tool should now show the ‘CADfix License’ service as running: 

 
If the license service will not start, then see License service not starting below. 

 

 

9. The LMTools utility program can now be exited (File → Exit). 

 

 

Note: If the ‘CADfix License’ service needs to be stopped/started/restarted, then this can be done via 

the LMTOOLS ‘Start/Stop/Reread’ tab, or via the Windows Services tool. Alternatively, this can be done 

using the Windows Services app – See CADfix license services.  

 

 

 

 

 

 

 

3.4. License service not starting 

If the license service will not start, then this may be due to local administration rights. To overcome this: 

 

1. Start the Windows Services tool and Right-click 

on the service 'CADfix license'. 

 

2. Select Properties. 

 

3. Change "log on as" from 'This account' to 'Local 

System account' 

 

4. Restart the license service. 

 

5. If the license service still does not start, then 

contact CADfix support for further help. 
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3.5. Recording License server information 

During the configuration of the CADfix License (section 3.3.6) a ‘Path to the debug log file’ was 

specified (e.g.“C:\Program Files (x86)\CADfix\lic\cadfix.log”).  This log file contains the license server’s 

configuration and license activities. 

Open the log file with a text editor then find and record the following information: 

 FLEXnet version number:  ...................................................................  

 Server network name or IP address:  ...................................................................  

 License file name and path:  ...................................................................  

Lmgrd (license manager daemon) port number:  ...................................................................  

 Itiohio (vendor daemon) port number:  ...................................................................  

 Itiohio (vendor daemon) version number:  ...................................................................  

 Method of linking to license server:  Local license  Short license  Environment variable 

 

The following is an extract from a cadfix.log file with this key information highlighted: 

  

FlexNET version number 

Server network name or IP address 

License file name and path 

Lmgrd port number 

Itiohio port number 

Itiohio version number 
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3.6. Linking CADfix to the license 

To allow CADfix to start, it needs to link to a valid license, and there are three options for this: 

When you have configured your installation, record which method you used on the form in section 3.5. 

 

Evaluation license 

Single node-locked 

3.6.1. Local license file 

Check the license file has been copied into the client’s local “[CADfix installation]\lic” folder.  

(This should have already been done in section 3.2) 

 

 

Network (floating), or multiple node-locked 

3.6.2. Environmental variable 

An environmental variable can be set up for each user, this tells CADfix how to contact the 

server: 

CADFIX_KEY=[lmgrd port]@[server name] 

 e.g. 

CADFIX_KEY=32768@mainland 

The actual values used in this variable can be found in the license server log file. 

 

 

3.6.3. Cut-down license file 

A ‘cut-down license file’ can be used as an alternate method of connecting CADfix to the license 

server. For further help with this, please contact CADfix support. 

 

 

3.6.4. License connection errors 

If an error occurs when CADfix is trying to communicate with the license server, then a ‘FlexNET 

license finder’ error will be displayed. – Cancel this error. 

This will then be followed with a ‘Fatal error’ message which will show the full error text – take a 

screenshot of this so you can share it with CADfix support. 

Following an installation, the biggest cause of license errors is because a firewall has blocked 

communications on ports that are being used by the license server. These port numbers are shown in 

the license log file (see ‘lmgrd port number’ and ‘itiohio port number’ in previous section). 

1. The CADfix license server needs firewall exceptions to allow inbound communications on the 

‘lmgrd’ and ‘itiohio’ ports. 

2. CADfix client machine (running CADfix) should not need any exceptions to its firewall. 

For further support on licensing problems, please contact CADfix support.  
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4. Updating CADfix 
 

4.1. Updating your CADfix installation 

As part of the Maintenance, Enhancements, and Support (ME&S) package, you will be offered an 

upgrade for your CADfix. For most CADfix releases, the license manager will remain unchanged, and 

will therefore not need upgrading. If the license manager does need upgrading, then this will be 

highlighted in the “What’s new…” release document.  

 

Service packs are supplied with their own installation instructions. 

 

 

Evaluation license 

If you are using an evaluation license of CADfix, then you will just need to uninstall your current CADfix 

installation and then install the newer version. – see Installing CADfix 

 

 

Single node-locked 

If you are using a node-locked license where the license server is part of the CADfix installation you are 

using, then: 

 

Recommended 

1) Pause the license service – See CADfix license services. 

2) (Optionally) uninstall your existing CADfix installation (this will also uninstall the license server files) 

3) Install the new version of CADfix – See Installing CADfix 

4) Configure the license services using this new installation – See Configuring the license manager 

 

Alternatively follow the procedure for ‘Floating and Multi-seat node-locked licenses’ to reconfigure 

CADfix to get its license from the license server in the older installation. If the FlexNET licensing service 

has been updated in the new release, then this license server will also need updating - Contact CADfix 

support for more information. 

 

 

Network (floating), or multiple node-locked 

1) (Optionally) uninstall your existing CADfix installation. 

2) Install the new CADfix installation – See Installing CADfix 

3) Link CADfix to license server if needed. If the variable ‘CADFIX_KEY’ has been used here, then this 

step is not needed – See Linking CADfix to the license 

4) If the license manager needs updating, then see Upgrading FlexNET license service files 
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4.2. Updating your CADfix license file 

Periodically the license file you have been provided with will expire.  If this happens and you have not 

yet received an updated file, then contact your CADfix supplier. 

 

Evaluation license 

If you are using an evaluation licence, then: 

a) Make sure CADfix is not running. 

b) Copy the new license file into cadfix\lic.  - Any existing license file can be overwritten. 

c) Restart CADfix, and it will automatically read this new license file. 

d) Once started, go to the pull-down menu ‘Help’ → ‘About CADfix’. This dialogue will show the 

modules that are licences, and the new license expire date. 

 

Single node-locked 

If you are using a node-locked license and running through a license file that is part of your 

CADfix installation, then: 

a) Make sure CADfix is not running. 

b) Copy the new license file into cadfix\lic.  - Any existing license file can be overwritten. 

c) Restart the FlexNET services – See CADfix license services. 

d) Restart CADfix and it will automatically read this new license file. 

e) Once started, go to the pull-down menu ‘Help’ → ‘About CADfix’. This dialogue will show the 

modules that are licences, and the new license expire date. 

 

Network (floating), or multiple node-locked 

If you are using a floating license as part of your CADfix installation, then: 

a) Make sure CADfix is not running. 

b) Copy the new license file into cadfix\lic.  - Any existing license file can be overwritten. 

c) Restart the FlexNET services – See CADfix license services. 

d) If you have linked your CADfix installation to the license service using a full license file, then 

copy the new license file into the cadfix\lic folder on the local CADfix client machine. 

f) Restart CADfix and it will automatically read this new license file. 

g) Once started, go to the pull-down menu ‘Help’ → ‘About CADfix’. This dialogue will show the 

modules that are licences, and the new license expire date. 
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4.3. CADfix license services 

 

1) Start the Windows Services App. 

 

2) Scroll down and select the “CADfix License” service. – Be aware that this service may have been 

named differently during the initial CADfix installation. 

 
 

3) The Action dropdown menu provides options to Start, Stop, Pause, Resume, and Restart the 

license service. Some of these options will be greyed out depending on the service’s current status. 

 
 

 

4.4. Upgrading FlexNET license service files 

 

1) Pause the license service – See CADfix license services. 

 

2) Copy new FlexNET license service files into the lic folder to replace the existing ones. 

The list of files include: lmtools.exe, lmutil.exe, lmgrd.exe, and itiohio.exe 

 

3) Check you have the latest license file in the CADfix\lic folder.  This should have an expire date after 

today, and valid to operate with this version of CADfix. – Speak to CADfix support to verify this. 

 

4) Restart the license service – See CADfix license services. 

 

 


